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About this document
Scope and purpose

This user guide enables users to use the KIT_T2G_C-2D-4M_LITE low-cost evaluation kit, also known as the
TRAVEO™ T2G Cluster 4M Lite Kit. It is based on the CYT3DL device from the TRAVEO™ Cluster 2D family of
microcontrollers with onboard EZ-USB™ FX3.
This document describes the features and functions of the TRAVEO™ T2G Cluster 4M Lite Kit. It also provides
detailed information on available interfaces and the usage of all hardware interfaces.
Intended audience

This document is intended for software and hardware engineers evaluating the TRAVEO™ T2G Cluster 2D family
CYT3DL device. Its main purpose is to offer a comprehensive guide that outlines the various features of the
device and how it can be used in a range of applications. Whether you are testing a new software or exploring
different hardware designs, this document provides valuable insights and guidance to help you achieve your
goals.
Evaluation board

This board is to be used during the design-in process for evaluating and measuring characteristic curves, and
for checking datasheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
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Important notice
“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).
Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards has
been tested by Infineon Technologies only as described in this document. The design is not qualified in
terms of safety requirements, manufacturing and operation over the entire operating temperature range
or lifetime.
The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).
Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.
The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.
It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.
The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.
The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.
Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.
Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions
Note: Please note the following warnings regarding the hazards associated with development systems.

Table 1 Safety precautions

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when installing,
testing, servicing or repairing the assembly. Component damage may result if ESD control
procedures are not followed. If you are not familiar with electrostatic control procedures, refer
to the applicable ESD protection handbooks and guidelines.

Caution: The evaluation or reference board is shipped with packing materials that need to be
removed prior to installation. Failure to remove all packing materials that are unnecessary for
system installation may result in overheating or abnormal operating conditions.
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1 Getting started
This section provides an overview of the TRAVEO™ T2G Cluster 4M Lite Kit and offers step-by-step guidance on
how to set up and power up the kit. Additionally, it includes instructions on running the preprogrammed
firmware and configuring the default jumpers to ensure a seamless experience.

1.1 Kit overview
This section provides a brief introduction to the TRAVEO™ T2G Cluster 4M Lite Kit and details all the various
interfaces and peripherals available in this kit.

1.1.1 Introduction
The TRAVEO™ T2G Cluster 4M Lite Kit belongs to the TRAVEO™ Cluster 2D graphics family, featuring the TRAVEO™

T2G CYT3DL device as the MCU and an onboard EZ-USB™ FX3 with a USB Type-C connector for streaming RGB
graphics data packets to a PC screen. This kit is primarily designed to evaluate the functions and features of the
CYT3DL series microcontroller.
The TRAVEO™ T2G Cluster 4M Lite Kit includes:
• A TRAVEO™ T2G CYT3DL MCU
• An EZ-USB™ FX3 with a USB Type-C connector
• SMIF for interfacing HYPERBUS™ memories such as SEMPER™ Flash and HYPERRAM™

• An onboard PSOC™ 5LP (KitProg3) programmer/debugger with a USB Micro-B connector
• General-purpose I/O headers for interfacing with various external shield kits

1.1.2 Features
The main features of the TRAVEO™ T2G Cluster 4M Lite Kit include:
MCU device: TRAVEO™ T2G CYT3DL
Graphics and video interfaces:
• MIPI CSI-2 camera interface
• Single-channel FPD-Link/LVDS interface for up to 1920 x 720 video output
• EZ-USB™ FX3 device that converts RGB graphics data packets into USB packets
Program and debug interfaces:
• Arm® standard 20-pin JTAG header
• PSOC™ 5LP (KitProg3) as onboard programmer/debugger
Crystal oscillators:
• 16 MHz external crystal oscillator
• 32.768 kHz watch crystal oscillator
Serial memory interface:
• 64 Mb HYPERRAM™

• 512 Mb SEMPER™ Flash
General-purpose I/O headers:
• Shield2Go header
• mikroBUS header
• Header compatible with Arduino
• Raspberry Pi-compatible I/O header
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Communication interfaces:
• PMOD connector to support external Ethernet PHY shields
Human interfaces:
• User LEDs
• Push button
• Potentiometer
Connectors:
• 12 V DC power jack for powering the kit
• USB Micro-B connector for powering the kit and programming/debugging via the onboard programmer

and debugger PSOC™ 5LP (KitProg3)
• USB Type-C connector for powering the kit and streaming EZ-USB™ FX3 graphics data output to the PC

screen
Figure 1 shows the block diagram of the TRAVEO™ T2G Cluster 4M Lite Kit, highlighting only the major
interfaces. There may be additional blocks between the CYT3DL device and the peripheral component blocks.

T2G connected peripherals
PSOC™ device
Power supply
External shields
Users PC
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Figure 1 Block diagram of TRAVEO™ T2G Cluster 4M Lite Kit

1.1.3 Peripheral details
This section provides an overview of the various interfaces and peripherals available in the TRAVEO™ T2G
Cluster 4M Lite Kit.
Table 2 shows the peripheral markings, reference designators, and details about them, which are highlighted in
Figure 2.
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Figure 2 Peripherals and interfaces in the TRAVEO™ T2G Cluster 4M Lite Kit

Table 2 Peripheral details

Markup Reference designator Description

1 X100 12 V DC power jack for connecting the wall adapter to
power the kit

2 D104 3.3 V power monitor LED

D102 1.1 V power monitor LED

D103 1.2 V power monitor LED

3 X500 USB Type-C connector for streaming data packets of
EZ-USB™ FX3 as well as for powering the kit

4 U500 EZ-USB™ FX3 for converting RGB graphics output data
packets to USB data packets

5 U601 64 Mb HYPERRAM™ connected to the SMIF-1 interface

6 U600 512 Mb SEMPER™ Flash connected to the SMIF-0
interface

7 U200 TRAVEO™ T2G CYT3DL MCU

8 X700 FPD-Link interface that supports FPD-Link display
(table continues...)
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Table 2 (continued) Peripheral details

Markup Reference designator Description

9 X701 MIPI CSI-2 interface that supports MIPI CSI-2 camera
module

10 Y300 32.768-kHz watch crystal oscillator

11 Y301 16-MHz external crystal oscillator

12 X801 PMOD connector that supports external Ethernet PHY
shield kits

13 X302 Arm® Standard 20-pin JTAG connector for programming
and debugging the kit

14 X802 10-pin Arduino shield-compatible I/O header

X806 8-pin Arduino shield-compatible I/O header

15 S800 Shield2Go header footprints

16 S801 Shield2Go1 header footprints

17 X803 8-pin Arduino shield-compatible I/O header

X805 9-pin Arduino shield-compatible I/O header

18 X400 USB Micro-B connector for programming and
debugging using PSOC™ 5LP (KitProg3) as well as for
powering the kit

19 U400 PSOC™ 5LP (KitProg3) as onboard programmer and
debugger

20 X800 40-pin Raspberry Pi shield-compatible I/O header

21 S400 KitProg3 mode select push button

22 X813 8-pin mikroBUS shield-compatible I/O header

23 S200 MCU device reset button

24 S900 User push button for human interface

25 X812 8-pin mikroBUS shield-compatible I/O header

26 R904 Resistor-based rotary potentiometer

27 D900 User LED1 for human interface

28 D901 User LED2 for human interface

29 X502 EZ-USB™ FX3 bootloader jumper

30 S500 EZ-USB™ FX3 reset button

1.2 Kit contents
This section provides a detailed list of the components included with this kit.
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Table 3 Kit contents

Quantity Description Remarks

1 KIT_T2G_C-2D-4M_LITE Rev-01 TRAVEO™ T2G Cluster 4M Lite Kit

1 USB Type-C to Type-C cable For powering the board and streaming EZ-
USB™ FX3 graphics data output

Figure 3 Kit contents of TRAVEO™ T2G Cluster 4M Lite Kit

1.3 Initial jumper configuration
This section describes the default jumper configuration and location required for each module. Because a few
interfaces are multiplexed, the default interface selection is mentioned in Table 4. This jumper configuration
also helps to generate all the power supplies from the regulators and distribute them to safely power the Lite
kit.
Figure 4 shows the location of various jumpers available on the TRAVEO™ T2G Cluster 4M Lite Kit.
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Figure 4 Location of all the jumpers in the TRAVEO™ T2G Cluster 4M Lite Kit

Table 4 Jumper configuration

Jumper Function Position: selection

X101 3.3 V PMIC 1-2: short (default)

1-2: open

X102 1.1 PMIC 1-2: short (default)

1-2: open

X103 12 V VIN selected 1-2: short

5 V VIN selected 2-3: short (default)

X104 12 V input 1-2: open

5 V input 1-2: short (default)

X200 VDDA selected to 3.3 V 1-2: short (default)

VDDA selected to 5 V 2-3: short

X201 VDDIO selected to 3.3 V 1-2: short (default)

VDDIO selected to 5 V 2-3: short

X300 KitProg3 RX 1-2: short (default)
(table continues...)
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Table 4 (continued) Jumper configuration

Jumper Function Position: selection

mikroBUS SPI CLK 2-3: short

X301 KitProg3 TX 1-2: short (default)

mikroBUS SPI MOSI 1-2: open

X402 VBUS power enabled from Micro-B 1-2: short (default)

VBUS power disabled from Micro-B 1-2: open

X403 KitProg3 will not reset 1-2: open (default)

KitProg3 will reset 1-2: short

X502 FX3 will not be in bootloader mode 1-2: open (default)

FX3 will be in bootloader mode 1-2: short

X804 VIN for Arduino header 1-2: short (default)

No VIN for Arduino header 1-2: open

X808 3.3 V for RPi header 1-2: short (default)

No 3.3 V to RPi header 1-2: open

X809 TDM RX FSYNC going to RPi header 1-2: short

TDM RX FSYNC to TX FSYNC 2-3: short (default)

X810 TDM RX MCLK going to RPi header 1-2: short

TDM RX MCLK to TX MCLK 2-3: short (default)

X811 TDM RX SCK routed to RPi header 1-2: short

TDM RX SCK to TX SCK 2-3: short (default)

1.4 Powering the kit
This section provides step-by-step guidance on how to power up the kit using the different powering options
available on the TRAVEO™ T2G Cluster 4M Lite Kit.
The TRAVEO™ T2G Cluster 4M Lite Kit can be powered through any of these three options:
1. USB Type-C1)

2. USB Micro-B2)

3. 12 V DC power adapter3)

1.4.1 Powering through USB Type-C
1. Before connecting the USB Type-C to Type-C cable, short the jumpers as indicated below:

a. Short the 3-pin jumper (X103) between positions 2 and 3
b. Short the 2-pin jumper (X104)

1 This is the default powering option for this kit
2 KitProg3 will also be powered up with this option
3 If you are using an FPD-Link display with this kit, you will need this powering option, as the FPD-Link display will get power only

with this option
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2. Connect the USB Type-C to Type-C cable between the USB Type-C connector (X500) on the kit and the
USB Type-C port on the PC

3. Observe that the power LEDs (D104, D102, and D103) start glowing green

1.4.2 Powering through USB Micro-B
1. Before connecting the USB Micro-B cable, short the jumpers as indicated below:

a. Short the 3-pin jumper (X103) between positions 2 and 3
b. Short the 2-pin jumper (X104)
c. Short the 2-pin jumper (X402)

2. Connect the USB Micro-B4) cable between the USB Micro-B connector of KitProg3 (X400) and the USB
port of the PC

3. Observe that the power LEDs (D104, D102, and D103) start glowing green
4. Additionally, observe that the VBUS LED (D400) also starts glowing green

1.4.3 Powering through 12 V DC power adapter
1. Before connecting the 12 V DC power adapter to the kit, short the jumpers as indicated below:

a. Short the 3-pin jumper (X103) between positions 1 and 2
b. Remove the 2-pin jumper (X104)

2. Connect the 12 V DC power adapter5) to the 12 V DC power jack (X100) on the kit
3. Observe that the power LEDs (D104, D102, and D103) start glowing green
Figure 5 shows the various powering option connectors available in the TRAVEO™ T2G Cluster 4M Lite Kit.

4 Not a part of the kit content
5 The 12-V DC power adapter should support at least 12 V, 1 A, while the preferable rating is 12 V, 3 A
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Figure 5 Various powering options in TRAVEO™ T2G Cluster 4M Lite Kit

1.5 Preprogrammed firmware
The TRAVEO™ T2G Cluster 4M Lite Kit is shipped with preloaded software that is ready to run as soon as the kit is
powered up. This software prints the MCU silicon details and the results of all the interfaces tested on this kit.
Additionally, there is preloaded firmware for the EZ-USB™ FX3, which streams the IRIS test pattern image on any
media player display on the PC screen by connecting a USB Type-C to Type-C cable to the PC.
To get started with the preloaded software, you must ensure that you have followed the correct jumper settings
and powered up the TRAVEO™ T2G Cluster 4M Lite Kit.

1.5.1 Silicon details and peripherals test result logs firmware
To view the MCU silicon details and the peripherals test result logs on your screen, along with a blinking pattern
of the user LEDs, do the following:
1. Connect the kit to your PC via the USB Micro-B cable
2. Open any serial terminal software (such as Tera Term) on your PC
3. Configure for a Serial connection and choose the port that shows KitProg3 USB-UART in the port option
4. Navigate to Setup > Serial port > Speed and select 115200 as the baud rate. Then, click the New setting

button to create a new configuration
5. Press the MCU reset button (S200) on the kit. You should be able to see the silicon details and test results

of the peripherals printed on your serial terminal screen, as shown in Figure 6
6. Observe that the user LEDs (D900 and D901) on the kit will start blinking in a pattern
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Figure 6 Silicon details printed on the serial terminal window of Tera Term

1.5.2 IRIS test image firmware
To see the IRIS test image on the screen via EZ-USB™ FX3, follow the steps mentioned below:
1. Ensure that the jumper (X502) is not shorted. If it is shorted, then remove that jumper
2. Disconnect the power from the kit and follow the steps mentioned in Powering through USB Type-C
3. Ensure that the USB Type-C to Type-C cable is connected to the USB 3.0 SuperSpeed USB Type-C port on

the PC, as EZ-USB™ FX3 supports only USB 3.0 ports
4. Follow the steps mentioned in Streaming the EZ-USB™ FX3 to install and use the TRAVEO™ T2G Virtual

Display Tool for streaming the FX3 test image firmware
5. Observe that the IRIS test pattern appears on your screen, as shown in Figure 7
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Figure 7 IRIS test pattern coming on the screen
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2 Programming the kit
This section provides information about the available programming interfaces in this kit and how to program
and debug the kit using these interfaces and various programming tools.
This kit supports programming and debugging using third-party software, as shown in Table 5.

Table 5 Programming tools and software IDEs supported

Programming IDEs/Tools Debugger/Probes

AutoFlashUtility v1.3 Onboard programmer/debugger KitProg3

IAR Embedded Workbench for Arm® v9.32.1 I-jet debugger + JTAG to 20-pin Arm® converter

Onboard programmer/debugger KitProg3

Green Hills Software MULTI v7.1.4 Green Hills Compiler v2017.1.4Probe v6.4.4

2.1 Programming interfaces
This section provides basic information about the programming interfaces available in the TRAVEO™ T2G
Cluster 4M Lite Kit.
There are two programming interfaces available in the TRAVEO™ T2G Cluster 4M Lite Kit:
• Onboard programmer/debugger KitProg3
• Arm® standard 20-pin JTAG connector

Onboard programmer/
debugger KitProg3

Arm® standard 20-pin JTAG 
connector

Figure 8 Programming interfaces available on the kit
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2.2 Blink the LED
This section provides instructions on how to blink the user LEDs using the IAR Embedded Workbench for Arm®

9.32.1 tool with the TRAVEO™ T2G Cluster 4M Lite Kit.

2.2.1 IAR Embedded Workbench for Arm®

Before programming and debugging the LED blinky code, follow the below steps as one-time setup for
prerequisites and tool installation.
1. Download the latest T2G Sample Driver Library for the TRAVEO™ T2G Cluster 4M Lite Kit to your PC
2. Install the SDL in a location outside the default program files so that the IDE can easily access and create

temporary files
3. Open the Readme.pdf file available inside the SDL folder and use the provided link from that file to

download the version of IAR EWARM that is supported by that SDL version
4. Download the IAR Embedded Workbench software and run the installation, keeping in mind that it might

take some time
5. When you open IAR EWARM for the first time, select the license in the License wizard. If you do not have

the license, register for a code size limited license type
6. After downloading and setting up the IDE, extract the folder from the path: SDL (v7.9.0 or higher)

-> misc. -> tools -> iar -> IAR_EWARM_9301_FlashLoader_Patch_TraveoII.zip. Follow the instructions
from the readme.txt document file available in that folder for copying the patch files to support SDL and
the device with that IAR Embedded Workbench IDE

7. The IAR Embedded Workbench for Arm® tool and T2G SDL drivers are now ready for programming and
debugging the TRAVEO™ T2G Cluster 4M Lite Kit

2.2.1.1 Programming using the onboard debugger KitProg3
This section describes how to program the TRAVEO™ T2G Cluster 4M Lite Kit using the onboard programmer and
debugger, KitProg3. Follow the steps below to program and debug the kit using the IAR Embedded Workbench
for Arm® tool and the onboard KitProg3 programmer/debugger:
1. Before connecting any power or cable, ensure that the jumpers are shorted as mentioned below:

a. 3-pin jumper (X103) – shorted between positions 2-3
b. 2-pin jumper (X104) – shorted
c. 2-pin jumper (X402) – shorted

2. Now, connect the USB Micro-B cable between the USB Micro-B connector of KitProg3 (X400) and the USB
port of the PC

3. Observe that the power LEDs (D104, D102, and D103) and the VBUS LED (D400) start glowing green. If the
LEDs are not glowing, refer to the default jumper configuration table in Initial jumper configuration and
Powering through USB Micro-B

4. Open IAR Embedded Workbench 9.32.1, and navigate to File > Open Workspace. Then,
navigate to the path where you have installed the T2G SDL, and select the following path:
T2G_Sample_Driver_Library_7.9.0\tviic2d4m\tools\iar\flash\tviic2dd4m_flash_cm0plus_template

5. Select the lite_kit revision from the drop-down list under Workspace in the Workspace tab
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Figure 9 Selecting lite_kit workspace for TRAVEO™ T2G Cluster 4M Lite Kit in IAR
6. Expand the src folder in the Workspace tab to locate the main_cm0plus.c file
7. To ensure that the correct debugger is selected, right-click on cm0plus – lite_kit in the Workspace

window, choose Options, and then select Debugger. Navigate to the Setup tab, and under Drivers,
select the CMSIS DAP option, then press OK
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Figure 10 Checking the debugger option in IAR
8. To initiate the build process, right-click on cm0plus – lite_kit in the Workspace window and select

Rebuild All
9. Monitor the Build Log for any errors and warnings as the rebuild process starts. If the build window is

not visible, navigate to View > Messages > Build
10. To load the program into the flash region of the CM0+ core, click the Download and Debug icon in the

toolbar. Then click the Go icon to start execution
11. In the Debug window, you can also use function keys on the keyboard:

• F5 (Go)
• F10 (Step Over)
• F11 (Step Into)
• Ctrl+D (Download and Debug)

12. During free-running execution, you should see user LED 1 (D900) blinking on the board
13. Follow the same steps for the CM7 core, and you should observe user LED 2 (D901) starting to blink

similarly to user LED 1 (D900)

2.2.1.2 Programming using IAR Systems I-jet debugger
This section describes how to program the TRAVEO™ T2G Cluster 4M Lite Kit using the IAR Systems I-jet
debugger. Follow these steps to program the kit using the IAR Embedded Workbench for Arm® tool and the IAR
Systems I-jet debugger:
1. See Powering the kit for selecting any of the three powering options to power up the kit
2. After powering up the kit, ensure that you have the JTAG-to-20-pin Arm® converter with you as shown

in Figure 11. Connect the JTAG-to-20-pin Arm® converter to the Arm® standard 20-pin JTAG connector
(X302). Then, connect the i-jet debugger to the JTAG-to-20-pin Arm® converter
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Figure 11 ADA-MIPI20-TI14 adapter
3. Open the IAR Embedded Workbench 9.32.1 and navigate to File > Open Workspace.

Navigate to the path where you have installed the T2G SDL, and select the following path:
T2G_Sample_Driver_Library_7.9.0\ tviic2d4m\ tools\ iar\ flash\ tviic2dd4m_flash_cm0plus_template

4. Select the lite_kit revision from the drop-down list under Workspace in the Workspace tab

Figure 12 Selecting lite_kit workspace for TRAVEO™ T2G Cluster 4M Lite Kit in IAR
5. Expand the src folder in the Workspace tab to locate the main_cm0plus.c file
6. To ensure that the correct debugger is selected, right-click on cm0plus – lite_kit in the Workspace

window, choose Options, and then select Debugger. Navigate to the Setup tab, select I-jet under
Drivers, and press OK
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Figure 13 Checking the debugger option in IAR
7. For the build, right-click on cm0plus – lite_kit in the Workspace window and select the Rebuild All

option
8. Check for errors and warnings in the Build Log as the rebuild process begins. If the build window does

not appear on the screen, go to View > Messages > Build
9. To load the program to the flash region of the CM0+ core, click the Download and Debug icon in the

toolbar
10. Click the Go icon to start the execution. Function keys from the keyboard can also be used in the Debug

window:
• F5 (Go)
• F10 (Step Over)
• F11 (Step Into)
• Ctrl+D (Download and Debug)

11. In free-running execution, user LED 1 (D900) will start blinking on the board
12. Follow the same steps for the CM7 core and observe user LED 2 (D901) also starting to blink, similar to

user LED 1 (D900)

2.2.2 Green Hills Software MULTI
This section describes how to program the TRAVEO™ T2G Cluster 4M Lite Kit using the Green Hills Software
MULTI IDE and GHS probe. Before programming and debugging the LED blinky code, follow these steps for a
one-time setup of prerequisites and tools installation:
1. Download the latest T2G Sample Driver Library (SDL) for the TRAVEO™ T2G Cluster 4M Lite Kit to your PC
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2. Install the SDL in a location outside the default program files so that the IDE can easily access and create
temporary files

3. Open the Readme.pdf file available inside the SDL folder. Read this file to get the details about the GHS
Tool Chain version supported by that SDL version, and install the recommended version on your PC

4. After installing the GHS MULTI tool and probe firmware, navigate to the folder path misc/tools/ghs inside
the T2G Sample Driver Library. Follow the steps mentioned inside the readme.txt files from both the
debugging and ghs_comp_xxxxxx_defaults_flash directories

5. After following the steps from both readme.txt files, the GHS MULTI tools will be ready to program and
debug the TRAVEO™ T2G Cluster 4M Lite Kit

Follow these steps to program the kit using the GHS MULTI tool and GHS probes:
1. See Powering the kit for selecting any of the three powering options to power up the kit
2. After powering up the kit, connect the GHS probe directly to the Arm® standard 20-pin JTAG connector

(X302) in the kit
3. Open File Explorer and navigate to the location where you have installed the T2G

Sample Driver Library (SDL). Then, navigate to the following path and open the template:
T2G_Sample_Driver_Library_7.9.0\tviic2d4m\tools\ghs\tviic2d4m_rev_c_template.gpj

4. Right-click on the tviic2d4m_common.gpj file in the tviic2d4m_rev_c_template.gpj window tab and select
the Edit option. A new window of the MULTI Editor will open on the PC screen

5. In the MULTI Editor window, uncomment the macro DEVICE=CYT3DLBBHS and comment the macro
DEVICE=CYT3DLABHS. Also, uncomment the macro CPU_BOARD=CY_272BGA_EVKLITE_rev_a and comment the
macro CPU_BOARD=CY_216TEQFP_EVK_rev_a as shown in Figure 14. Save and close the file

Figure 14 Setting up for the lite kit in the GHS workspace
6. In the tviic2d4m_rev_c_template.gpj window tab, navigate to the Build tab and select the option

Rebuild tviic2d4m_common.gpj to build the code. Wait for the build to be successful, which you can
verify in the status tab below the tviic2d4m_rev_c_template.gpj window tab

7. Once the build is successful, expand the tviic2d4m_common.gpj, then expand the _gpj/flash.gpj file.
Single-click on the file flash\cm0plus_only.ghsmc and press the F5 key on the keyboard

8. A new MULTI Debugger window will pop up on the PC screen. In that window, press the D button in the
debugging tab, and then press the F button to flash the code to the TRAVEO™ T2G Cluster 4M Lite Kit

TRAVEO™ T2G Cluster 4M Lite Kit user guide
KIT_T2G_C-2D-4M_LITE
2  Programming the kit

User guide 23 002-39200 Rev. *B
2025-06-11



9. Once the flashing is completed, the code will hit the breakpoint in the main function. Press the F5 button
on the keyboard to run the code

10. After running the code, you will observe that user LED 1 (D900) starts blinking in green
11. You can follow the same steps to flash the code to the CM7 core, and you will observe that user LED 2

(D901) also starts blinking in green

2.2.3 AutoFlashUtility
To use the AutoFlashUtility tool with this kit, follow these steps:
1. Connect a USB Micro-B cable between the USB Micro-B connector for KitProg3 (X400) and the USB port

of your PC. This connection is necessary for using the onboard debugger/programmer KitProg3
2. Open the command prompt on your PC and run the required commands from the command prompt to

use the AutoFlashUtility tool for flashing codes

Note: The AutoFlashUtility tool does not support debugging and should be used only for programming. To
obtain the AutoFlashUtility tool, visit the Infineon AutoFlash Utility page on the web.
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3 Functional description
This section provides information about the major hardware blocks included in the TRAVEO™ T2G Cluster 4M
Lite Kit. Understanding these components helps in comprehending the capabilities and features of the kit,
which, in turn, facilitates the development of more effective designs and applications.
The TRAVEO™ T2G Cluster 4M Lite Kit includes a TRAVEO™ T2G CYT3DL MCU, an EZ-USB™ FX3, SMIF for
connecting HYPERBUS™ memories (SEMPER™ Flash and HYPERRAM™), a MIPI CSI-2 camera interface, an FPD-
Link display interface, an on-board programmer/debugger KitProg3, and several general-purpose I/O headers.

3.1 TRAVEO™ T2G MCU
The TRAVEO™ T2G Cluster 4M Lite Kit is designed to evaluate the features and functionality of the TRAVEO™ T2G
CYT3DL device. The CYT3DL family includes a 2D graphics engine, sound processing, an Arm® Cortex®-M7 CPU
running up to 240 MHz for primary processing, and an Arm® Cortex®-M0+ CPU for peripheral and security
processing.
The TRAVEO™ T2G CYT3DL comes in two unique packages: a 216-pin TEQFP and a 272-ball BGA. The TRAVEO™

T2G Cluster 4M Lite Kit uses the 272-ball BGA package.
While the TRAVEO™ T2G Cluster 4M Lite Kit provides various functionalities and features, some functionalities
and features supported by the TRAVEO™ T2G CYT3DL device may not be available on the Lite Kit due to design
limitations and the availability of certain peripherals and pins.
The table below provides an overview of the functionalities and features supported on the TRAVEO™ T2G
Cluster 4M Lite Kit compared to those on the TRAVEO™ T2G CYT3DL device.

Table 6 Functionalities available on TRAVEO™ T2G Cluster 4M Lite Kit

Functionality/feature Supported on TRAVEO™ T2G Cluster 4M Lite Kit

FlexRay Not supported

CXPI Not supported

Ethernet Supported1) with external shields

CAN FD Supported2) with external shields

LIN Supported2) with external shields

UART Supported

I2C Supported

SPI Supported

ADC Supported

DMA Supported

RTC Supported

TCPWM Supported

SMIF Supported

IO Supported

Graphics Supported

CRYPTO Supported

I2S Supported3) with external shields

1) Supported with external Ethernet PHY, which can be connected to the PMOD connector (X801).
2) Supported only with the CY8CKIT-026 CAN and LIN Shield Kit, which you can connect using the Arduino headers.
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3) Supported only with external I2S shields, which can be connected via the Raspberry Pi IO header (X800).

3.2 Power supply
This section provides detailed information about the power supply and power flow in the TRAVEO™ T2G Cluster
4M Lite Kit, including how power is generated and distributed to the TRAVEO™ T2G CYT3DL MCU and various
components and peripherals in this kit.
To power up the TRAVEO™ T2G Cluster 4M Lite Kit, use any of the following options:
• USB Type-C6)

• USB Micro-B7)

• 12 V DC power adapter8)

This kit features an onboard PMIC module and LDOs to generate the necessary power supplies for the TRAVEO™

T2G CYT3DL MCU and other peripherals. The PMIC module can take input from a 12 V adapter or 5 V from the
USB connectors to generate voltages based on the kit's requirements and configurations. The PMIC output rails
can also drive other peripherals available on the kit.
Figure 15 illustrates the kit's power supply block diagram.

6 If you connect the USB Type-C to Type-C cable to a standard USB port on the PC, it will only power up the kit. However, if you want
to stream EZ-USB™ FX3 RGB packets to the screen, connect the cable to a USB 3.0 port on the PC.

7 KitProg3 is powered up only with this option. Therefore, if you want to use the onboard programmer/debugger KitProg3, ensure
that you are using this power option.

8 Ensure that the power adapter supports a minimum of 12 V/1 A power. However, a 12 V/3 A adapter is the default rating
recommended for use with this kit.
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Figure 15 Power supply block diagram

For the 12 V powering option, connect the jumpers as follows:
• Jumper X103: shorted between pins 1-2
• Jumper X104: open
For the 5 V powering option, connect the jumpers as follows:
• Jumper X103: shorted between pins 2-3
• Jumper X104: shorted
• Jumper X402: shorted
In the TRAVEO™ T2G Cluster 4M Lite Kit:
• The primary supply comes from the IR3883 buck regulator
• The IR3883 buck regulator is used for converting 12 V DC or 5 V DC to 3.3 V DC
• The ISL9107IRZ-T buck regulator is used for converting 3.3 V to 1.1 V DC
• The kit includes other power LDOs to generate power supplies for various peripherals
• The TLS205B0 LDO regulator is used for generating power supplies of 1.2 V, 1.8 V, and 2.8 V
• The board generates 1.2 V, 1.8 V, and 2.8 V voltage rails for different peripherals such as Ethernet, MIPI

CSI-2, and FPD-Link display interfaces
Figure 16 explains the operation of 12 V and 5 V with VIN ORED connection in the TRAVEO™ T2G Cluster 4M Lite
Kit.

TRAVEO™ T2G Cluster 4M Lite Kit user guide
KIT_T2G_C-2D-4M_LITE
3  Functional description

User guide 27 002-39200 Rev. *B
2025-06-11



12-V 
Operation

5-V 
Operation

PVIN

X103 1-2

X104 OPEN

VIN

VCC 5V

VIN 
ORED

GND

PVIN

X103 2-3

X104 CLOSE

VIN

VCC 5V

VIN 
ORED

GND
12-V power

Legends

5-V power

GND

Figure 16 Power operation block diagram

3.3 Clock
This section provides information about the various crystal oscillators available on the TRAVEO™ T2G Cluster 4M
Lite Kit that are used for clocking the TRAVEO™ T2G CYT3DL MCU and other peripherals.
The TRAVEO™ T2G Cluster 4M Lite Kit contains several crystal oscillators for clocking the TRAVEO™ T2G CYT3DL
MCU and other peripherals, which are listed in Table 7.

Table 7 Crystals available in this kit

Crystal oscillator Reference designator Frequency

Watch Crystal Oscillator (WCO) Y300 32.768 kHz

External Crystal Oscillator (ECO) Y301 16 MHz

Crystal oscillator for EZ-USB™ FX3 Y500 19.2 MHz

3.4 Reset
This section describes how to reset the TRAVEO™ T2G CYT3DL MCU using the MCU reset button (S200). The MCU
reset button (S200) is specifically designed to reset the TRAVEO™ T2G CYT3DL MCU and is connected to the XRES
pin of the MCU via a 10K resistor.
To reset the TRAVEO™ T2G CYT3DL MCU, simply press the reset button. This action connects the XRES pin to the
ground, initiating the reset process.
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3.5 User interfaces
The TRAVEO™ T2G Cluster 4M Lite Kit provides several interfaces for user interaction, including two user LEDs,
one push button, and a potentiometer interface. These interfaces are designed to facilitate the use of the kit for
developers and testers, allowing them to perform various operations and tests.

3.5.1 User LEDs
The user LEDs on the TRAVEO™ T2G Cluster 4M Lite Kit can operate across the entire voltage range of VDD. These
LEDs function as active HIGH, requiring the pins to supply VDD to turn them ON.

3.5.2 User push button
The user push button on the TRAVEO™ T2G Cluster 4M Lite Kit provides a means of input to the TRAVEO™ T2G
CYT3DL MCU. By default, pressing this button connects the TRAVEO™ T2G CYT3DL MCU pin to the ground.

3.5.3 Potentiometer
The TRAVEO™ T2G Cluster 4M Lite Kit features a 10 kΩ potentiometer that is connected to the TRAVEO™ T2G
CYT3DL MCU pin P7[0]. The potentiometer is used to simulate a sensor output to the TRAVEO™ T2G CYT3DL
MCU.

3.6 Graphics and video interfaces
This kit supports various video-compatible interfaces that can be accessed via specific connectors. These
interfaces are compatible with components, such as displays, cameras, and adapter boards.

3.6.1 EZ-USB™ FX3
This kit supports the FX3 video interface via a USB Type-C connector to stream the graphics output to the
screen. It is a plug-and-play device, as the EZ-USB™ FX3 comes with the necessary firmware preloaded. The RGB
display signals from the CYT3DL device are converted into USB 3.2 packets by the FX3 and streamed to a PC.
The PC detects the FX3 as a camera, allowing any media player application (such as MPC Player or VLC) to
display the graphics streamed by it.
For streaming, use the TRAVEO™ T2G Virtual Display Tool mentioned in Streaming the EZ-USB™ FX3.

Note: For more information, such as programming the EZ-USB™ FX3, see Programming the EZ-USB™ FX3.

3.6.1.1 Streaming the EZ-USB™ FX3
The following section provides a detailed, step-by-step guide for installing and running the TRAVEO™ T2G
Virtual Display Tool to stream the FX3 device as a camera.
1. Download the TRAVEO™ T2G Virtual Display Tool from the IDC webpage
2. Open the downloads folder and double-click on the

traveot2gvirtualdisplaytool_1.0.0_Windows_x64.exe file to launch the installer
3. During installation, select the recommended option for user access and proceed
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Figure 17 Installation of the tool
4. Accept the license agreement by reading through it and selecting I accept the agreement, then click

Next

Figure 18 License agreement
5. Choose the installation type. Select Quick Installation (Recommended) and click Install
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Figure 19 Quick installation
6. The tool will be installed automatically. Once completed, a Finish message will appear. Ensure the

checkbox for Run TRAVEO™ T2G Virtual Display Tool is selected, then click Finish
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Figure 20 Installation finish message in the installation wizard
7. The TRAVEO™ T2G Virtual Display Tool GUI will now open on your screen

Figure 21 TRAVEO™ T2G Virtual Display Tool GUI window

TRAVEO™ T2G Cluster 4M Lite Kit user guide
KIT_T2G_C-2D-4M_LITE
3  Functional description

User guide 32 002-39200 Rev. *B
2025-06-11



8. From the Capture Sources dropdown, select FX3. Next, choose the resolution for the captured video
from the Resolutions dropdown. For the default shipping firmware, select 800x480

Figure 22 Selecting FX3 and resolutions
9. After selecting the resolution, click Start Stream to begin streaming video from the FX3 source
10. Once streaming starts, the captured video or image will play in the Video Capture Window of the GUI

Figure 23 IRIS test pattern image streaming
11. To change the color mode, select the desired option (RGB or BGR) from the Colour Mode radio buttons
12. If the video freezes or gets stuck, the tool will automatically reconnect and resume video capture. If the

issue persists, press the MCU Reset button, then click Stop Stream, and finally click Start Stream to
restart the video stream
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3.6.2 FPD-Link interface
This kit includes one FPD-Link interface and supports graphics output. To stream graphics output, connect the
FPD-Link display, which is compatible with Innolux G070Y2-L01.
.

Attention: You will need to connect a 12 V DC power adapter if you are using the FPD-Link display with this
kit. See Powering through 12 V DC power adapter for step-by-step guidance on how to power this
kit using a 12 V DC power adapter.

3.6.3 MIPI CSI-2 interface
This kit supports the MIPI CSI-2 interface. Since the CSI-2 receiver is integrated into the CYT3DL device, you will
need an external camera module to transmit the video stream to the device. The MIPI CSI-2 camera interface
(X701) supports multiple imaging formats, including YUV, RGB, and raw formats. This connector is compatible
with an eCON camera module, specifically the e-CAM52A_5640_MOD MIPI camera.

3.7 Communication interfaces
The TRAVEO™ T2G Cluster 4M Lite Kit offers a range of communication interfaces, including I2C, SPI, UART, and
Ethernet. These interfaces can be used for various purposes, such as connecting to external devices or
communicating with other systems.

3.7.1 Ethernet
The TRAVEO™ T2G Cluster 4M Lite Kit includes a PMOD connector that can be used with an external Ethernet
shield module. The following section provides more details about the various Ethernet shield module kits that
are supported with this kit.

3.7.1.1 Ethernet PHY shields
The TRAVEO™ T2G Cluster 4M Lite Kit does not have an onboard Ethernet PHY. However, you can use external
Ethernet PHY boards by connecting them to the PMOD connector for Ethernet (X801) on the board. The
supported shields for Ethernet communication protocol are listed below:
• DP83848 Ethernet board: The DP83848 Ethernet board is an accessory board that includes an onboard

Ethernet Physical Layer Transceiver (DP83848), an RJ45 connector, and a control interface
• LAN8720 Ethernet board: The LAN8720 Ethernet board supports the RMII interface with a 10/100 Ethernet

Transceiver (LAN8720)
Figure 24 shows the available shields that you can use with the PMOD headers of this kit.
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DP83848 
Ethernet board

LAN8720
Ethernet board

Figure 24 Different Ethernet shields supported by the TRAVEO™ T2G Cluster 4M Lite Kit

Note: See the References section to obtain the ordering details for all these shield kits.

3.8 Serial memory interface
The TRAVEO™ T2G Cluster 4M Lite Kit includes a serial memory interface (SMIF) that acts as a master, providing
a low pin count connection to off-chip SPI devices, such as EEPROM, FRAM, MRAM, or NAND memories, in both
SDR and DDR modes. It also supports HYPERBUS™ devices, including HYPERFLASH™ (NOR flash) and
HYPERRAM™ (PSRAM and pseudo static RAM).
The TRAVEO™ T2G Cluster 4M Lite Kit has two onboard SMIF devices:
• 512 Mb SEMPER™ Flash (S26HL): Connected to the SMIF-0 instance
• 64 Mb HYPERRAM™ (S27KL): Connected to the SMIF-1 instance

3.8.1 SEMPER™ Flash
The TRAVEO™ T2G Cluster 4M Lite Kit features a 512 Mb SEMPER™ Flash (S26HL512T), a high-speed CMOS,
MIRRORBIT™ NOR flash device compliant with the JEDEC JESD251 eXpanded SPI (xSPI) specification. The
SEMPER™ Flash with HYPERBUS™ interface supports both the HYPERBUS™ interface and legacy (x1) SPI. Both
interfaces serially transfer transactions, thereby reducing the number of interface connection signals.
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3.8.2 HYPERRAM™

This kit includes a 64 Mb HYPERRAM™ self-refresh DRAM (PSRAM). The Infineon 64 Mb HYPERRAM™ (S27KL0642)
device is a high-speed CMOS, self-refresh DRAM with a HYPERBUS™ interface. The DRAM array uses dynamic
cells that require periodic refresh.
Note: For the datasheet and more details about SEMPER™ Flash and HYPERRAM™, see References.

3.9 Program and debug interface
This kit includes an onboard programmer/debugger, the PSOC™ 5LP (KitProg3), equipped with a USB Micro-B
connector for programming and debugging the CYT3DL device. Additionally, you can use the Arm® Standard 20-
pin JTAG connector to program and debug the CYT3DL device.

3.9.1 PSOC™ 5LP (KitProg3)
The KitProg3 (onboard programmer/debugger) is implemented using a PSOC™ 5LP device (CY8C5868LTI-LP039).
The PSOC™ 5LP handles the low-level communication firmware needed for programming and debugging,
facilitating communication between a programming tool and a target, such as the TRAVEO™ T2G Cluster 4M Lite
Kit.
In this kit, the KitProg3 is pre-configured to function as a USB-UART bridge for programming and debugging the
CYT3DL device. The kit also features a KitProg3 mode switch (S400) and a KitProg3 status LED (D401) (not
populated). These interfaces allow you to switch between various operating modes of KitProg3 and monitor its
status. Note that this board supports only CMSIS-DAP BULK mode.
Additionally, there is an optional programming header for programming the PSOC™ 5LP, available via the 5-pin
header (X401) (footprint only). It is important to note that the hardware revision ID of the KitProg3 is 0x08.
To use the onboard programmer/debugger KitProg3 on the TRAVEO™ T2G Cluster 4M Lite Kit, simply connect a
USB Micro-B cable to the USB Micro-B connector of KitProg3 (X400) and the USB port of your PC to program and
debug this kit.

3.9.2 Arm® Standard SWD/JTAG header
When it comes to programming and debugging the kit using the Arm® Standard 20-pin JTAG connector, use any
of the following options:
1. Using the GHS Probe: Connect the GHS Probe directly to the Arm® Standard 20-pin JTAG connector

(X302) for programming and debugging
2. Using the I-jet debugger: Use a JTAG-to-20-pin Arm® converter (ADA-MIPI20-TI14 adapter) to connect

the I-jet debugger to the Arm® Standard 20-pin JTAG connector (X302). This allows programming and
debugging with the I-jet debugger

These options provide flexibility in choosing the appropriate tools for programming and debugging the
TRAVEO™ T2G Cluster 4M Lite Kit.

3.10 General-purpose I/O headers
This kit provides a variety of general-purpose I/O headers that are compatible with popular interfaces. These
include:
• One Raspberry Pi-compatible I/O header
• Arduino-compatible headers
• mikroBUS-compatible headers
• Two Shield2Go footprints
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Additionally, this kit supports various shields to use different peripherals not available on the board. These
peripherals can be accessed by connecting to the I/O headers of the kit.

3.10.1 Raspberry Pi header

Table 8 Raspberry Pi header pin details

Pins Functionality

X800.1 3V3

X800.2 5V0

X800.3 SCB2 I2C SDA

X800.4 5V0

X800.5 SCB2 I2C SCL

X800.6 GND

X800.7 GPIO1 (P7.1)

X800.8 SCB6 UART RX

X800.9 GND

X800.10 SCB6 UART TX

X800.11 GPIO2 (P7.2)

X800.12 TDM TX SCK0

X800.13 GPIO3 (P7.3)

X800.14 GND

X800.15 GPIO4 (P8.0)

X800.16 TDM RX SCK0

X800.17 3V3

X800.18 TDM TX MCK0

X800.19 SCB7 SPI MOSI

X800.20 GND

X800.21 SCB7 SPI MISO

X800.22 GPIO9 (P7.1)

X800.23 SCB7 SPI CLK

X800.24 SCB7 SPI SEL0

X800.25 GND

X800.26 SCB7 SPI SEL1

X800.27 SCB2 I2C SDA

X800.28 SCB2 I2C SCL

X800.29 GPIO5 (P8.1)

X800.30 GND
(table continues...)
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Table 8 (continued) Raspberry Pi header pin details

Pins Functionality

X800.31 GPIO6 (P9.2)

X800.32 GPIO8 (P9.0)

X800.33 TDM RX MCK0

X800.34 GND

X800.35 TDM TX FSYNC0

X800.36 GPIO7 (P8.3)

X800.37 TDM RX FSYNC0

X800.38 TDM RX SD0

X800.39 GND

X800.40 TDM TX SD0

3.10.1.1 WM8960 Audio HAT
The TRAVEO™ T2G Cluster 4M Lite Kit includes a Raspberry Pi-compatible I/O header, which can be used to
connect the WM8960 Audio HAT for audio codec purposes. The WM8960 Audio HAT is a sound card HAT
designed for Raspberry Pi, featuring low power consumption, support for stereo encoding/decoding, and Hi-Fi
playback/recording capabilities.
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WM8690
Audio HAT

Figure 25 WM8960 Audio HAT

3.10.2 Arduino headers

Table 9 Arduino headers pin details

Arduino header pins Functionality

Arduino header X802

X802.1 LIN0 TX

X802.2 LIN0 RX

X802.3 SCB8 SPI SEL0

X802.4 SCB8 SPI MOSI

X802.5 SCB8 SPI MISO

X802.6 SCB8 SPI CLK

X802.7 GND

X802.8 VADC

X802.9 SCB2 I2C SCL

X802.10 SCB2 I2C SDA
(table continues...)
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Table 9 (continued) Arduino headers pin details

Arduino header pins Functionality

Arduino header X803

X803.1 VIN

X803.2 GND

X803.3 GND

X803.4 5V0

X803.5 3V3

X803.6 XRES#

X803.7 VDDIO

X803.8 NC

Arduino header X805

X805.1 AN1 (P4.4)

X805.2 AN2 (P4.5)

X805.3 AN3 (P2.0)

X805.4 AN4 (P5.0)

X805.5 SCB2 I2C SDA

X805.6 SCB2 I2C SCL

X805.7 DAC_AOUT_R

X805.8 DAC_AOUT_L

X805.9 DAC_COM_R

Arduino header X806

X806.1 LIN1 TX

X806.2 LIN1 RX

X806.3 DAC_COM_L

X806.4 GPIO3 (P11.1)

X806.5 CAN0 TX

X806.6 CAN0 RX

X806.7 GPIO2 (P8.2)

X806.8 GPIO1 (P4.2)

3.10.2.1 CY8CKIT-026 CAN and LIN Shield Kit
The TRAVEO™ T2G Cluster 4M Lite Kit supports the CY8CKIT-026 CAN and LIN Shield Kit, an Arduino-compatible
shield kit used for CAN and LIN communication capabilities.
By default, the TRAVEO™ T2G Cluster 4M Lite Kit does not include CAN and LIN transceivers. However, by using
this shield, you can enable those communication protocols on the kit.
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CY8CKIT-026 CAN LIN 
Shield Kit

Figure 26 CY8CKIT-026 CAN and LIN Shield Kit

3.10.3 mikroBUS headers

Table 10 mikroBUS headers pin details

mikroBUS header pins Functionality

mikroBUS header X812

X812.1 AN1 (P5.3)

X812.2 RST

X812.3 SCB7 SPI SEL0

X812.4 SCB7 SPI CLK

X812.5 SCB7 SPI MISO

X812.6 SCB7 SPI MOSI

X812.7 3V3

X812.8 GND

mikroBUS header X813

X813.1 GPIO1 (P19.3)
(table continues...)
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Table 10 (continued) mikroBUS headers pin details

mikroBUS header pins Functionality

X813.2 GPIO2 (P21.3)

X813.3 SCB6 UART RX

X813.4 SCB6 UART TX

X813.5 SCB2 I2C SCL

X813.6 SCB2 I2C SDA

X813.7 5V0

X813.8 GND

3.10.4 Shield2Go headers
Shield2Go footprints are available on this kit, and you can mount the headers based on your requirements.
Note: See Kit design documents for schematic drawings and pin details of these GPIO headers.
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4 Kit design documents
This section provides detailed information on resources that can be used to understand the layout, design, and
components of the TRAVEO™ T2G Cluster 4M Lite Kit. These resources include: layout images, schematics,
assembly drawings, bill of materials (BOM), and pinout details.

4.1 Schematics
This section provides the schematics for the TRAVEO™ T2G Cluster 4M Lite Kit Rev-01. These schematics can be
used to understand the electrical connections and components of the kit.
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Figure 27 Overview
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Figure 34 FPD-Link and MIPI CSI-2 interface
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SCB2_SDA
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TDM_RX_MCK0_RPI

TDM_TX_MCK0
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SCB2_SCL

SCB2_SDA
SCB2_SCL
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1
2
3
4
5
6
7
8
9 17

16
15
14
13
12
11
10

5V
AN1
AN2
SDA
SCL
GND
3V3
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Figure 35 I/O headers
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Figure 36 Reset button, LEDs, and potentiometer

4.2 Assembly drawing
This section provides the primary and secondary side assembly drawings for the TRAVEO™ T2G Cluster 4M Lite
Kit Rev-01. These drawings can be used to understand the physical layout and assembly of the kit.
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Figure 37 Primary side assembly of TRAVEO™ T2G Cluster 4M Lite Kit Rev-01
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Figure 38 Secondary side assembly of TRAVEO™ T2G Cluster 4M Lite Kit Rev-01
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4.3 Layout images

Figure 39 PCB fabrication
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Figure 40 Primary side layer 1
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Figure 41 Ground layer 2
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Figure 42 Signal layer 3
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Figure 43 Signal layer 4
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Figure 44 Power layer 5
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Figure 45 Secondary side layer 6

4.4 Bill of materials
This section provides the bill of materials (BOM) for the TRAVEO™ T2G Cluster 4M Lite Kit Rev-01, which is a
detailed list of all the components and parts that are included in the kit (see Table 11).
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4.5 Pinout details
This section provides information about the primary onboard functionalities of the TRAVEO™ T2G C-2D MCU
pins on the Lite Kit. It also includes details about the pins and their routing on the kit (see Table 12).

Table 12 KIT_T2G_C-2D-4M_LITE Rev-01 pin details

Pin Label Connection details

XRES XRES -

P0[0] WCI -

P0[1] WCO -

P0[2] ECI -

P0[3] ECO -

P1[0] LED1 USER LED1 (D900)

P1[1] LED2 USER LED2 (D901)

P1[2] SCB7 RX/CLK X300.2

P1[3] SCB7 TX/MOSI X301.2

P1[4] SCB7 MISO X800.21, X812.5

P1[5] SCB7 SEL0 X800.24

P1[6] LIN0 TX X802.1

P1[7] LIN0 RX X802.2

P2[0] AN3_ARD X805.3

P2[1] BUTTON USER PUSH BUTTON (S900)

P2[2] SWO_TDO X302.13

P2[4] SWCLK_TCLK X302.9

P2[5] SWDIO TMS X302.7

P3[0] SWDOE TDI X302.5

P3[1] TRSTN X302.3

P4[0] SCB6 RX X800.8, X813.3, S801.10

P4[1] SCB6 TX X800.10, X813.4, S801.11

P4[2] GPIO1_ARD X806.8

P4[3] SCB7 SEL1 X800.26, X812.3

P4[4] AN1_ARD X805.1

P4[5] AN2_ARD X805.2

P4[6] CAN1 0 TX X806.5

P4[7] CAN1 0 RX X806.6

P5[0] AN4_ARD X805.4

P5[1] LIN1 TX X806.2

P5[2] LIN1 RX X806.1
(table continues...)

TRAVEO™ T2G Cluster 4M Lite Kit user guide
KIT_T2G_C-2D-4M_LITE
4  Kit design documents

User guide 84 002-39200 Rev. *B
2025-06-11



Table 12 (continued) KIT_T2G_C-2D-4M_LITE Rev-01 pin details

Pin Label Connection details

P5[3] AN1_MB X812.1

P5[4] SCB2 SDA X800.27, X802.10, X805.5, X813.6

P5[5] SCB2 SCL X800.28, X802.9, X805.6, X813.5

P6[0] AN1_2G0_1 S800.2

P6[1] AN2_2G0_1 S800.3

P6[2] AN1_2G0_2 S801.2

P6[3] AN2_2G0_2 S801.3

P7[0] POT POT (R904)

P7[1] RPI_GPIO1 X800.7

P7[2] RPI_GPIO2 X800.11

P7[3] RPI_GPIO3 X800.13

P7[4] GPIO1_2GO_1 S800.8

P7[5] GPIO2_2GO_1 S800.9

P7[6] GPIO3_2GO_1 S800.12

P7[7] GPIO4_2GO_1 S800.13

P8[0] RPI_GPIO4 X800.15

P8[1] RPI_GPIO5 X800.29

P8[2] GPIO2_ARD X806.7

P8[3] RPI_GPIO7 X800.36

P8[4] GPIO1_2GO_2 S801.8

P8[5] GPIO2_2GO_2 S801.9

P8[6] GPIO3_2GO_2 S801.12

P8[7] GPIO4_2GO_2 S801.13

P9[0] RPI_GPIO8 X800.32

P9[1] RPI_GPIO9 X800.22

P9[2] RPI_GPIO6 X800.31

P9[3] SCB8 SEL1 S800.14

P9[4] SCB8 CLK X802.6, S800.15, S801.15

P9[5] SCB8 MOSI X802.4, S800.16, S801.16

P9[6] SCB8 MISO X802.5, S800.17, S801.17

P9[7] SCB8 SEL0 X802.3, S801.14

P11[0] RMII_REF_CLK X801.14

P11[1] GPIO3_ARD X806.4
(table continues...)
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Table 12 (continued) KIT_T2G_C-2D-4M_LITE Rev-01 pin details

Pin Label Connection details

P11[2] RMII_RXD0 X801.12

P11[3] RMII_RXD1 X801.11

P11[4] RMII_TXD0 X801.9

P11[5] RMII_TXD1 X801.8

P11[6] RMII_TXEN X801.10

P11[7] RMII CRS DV X801.13

P12[0] RMII_MDC X801.15

P12[1] RMII_MDIO X801.16

P12[2] TDM_TX_MCK0 X800.18

P12[3] TDM_TX_SCK0 X800.12

P12[4] TDM_TX_FSYNC0 X800.35

P12[5] TDM_TX_SD0 X800.40

P12[6] TDM_RX_MCK0 X800.33

P12[7] TDM_RX_SCK0 X800.16

P13[0] TDM_RX_FSYNC0 X800.37

P13[1] TDM_RX_SD0 X800.38

P13[2] RGB_BLUE7 -

P13[3] RGB_BLUE6 -

P13[4] RGB_BLUE5 -

P13[5] RGB_BLUE4 -

P13[6] RGB_BLUE3 -

P13[7] RGB_BLUE2 -

P14[0] RGB_BLUE1 -

P14[1] RGB_BLUE0 -

P14[2] RGB_GREEN7 -

P14[3] RGB_GREEN6 -

P14[4] RGB_GREEN5 -

P14[5] RGB_GREEN4 -

P14[6] RGB_GREEN3 -

P14[7] RGB_GREEN2 -

P15[0] RGB_GREEN1 -

P15[1] RGB_GREEN0 -

P15[2] RGB_RED7 -
(table continues...)
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Table 12 (continued) KIT_T2G_C-2D-4M_LITE Rev-01 pin details

Pin Label Connection details

P15[3] RGB_RED6 -

P15[4] RGB_RED5 -

P15[5] RGB_RED4 -

P15[6] RGB_RED3 -

P15[7] RGB_RED2 -

P16[0] RGB_RED1 -

P16[1] RGB_RED0 -

P16[2] RGB_CLK -

P16[3] RGB LVALID -

P16[4] RGB_VSYNC -

P16[5] RGB DE -

P16[6] - -

P16[7] RGB GPIO0 -

P17[0] RGB GPIO1 -

P17[1] RGB GPIO2 -

P18[0] SPIHB0 DATA4 TP607

P18[1] SPIHB0 DATA2 TP605

P18[2] SPIHB0 DATA3 TP606

P18[3] SPIHB0 DATA5 TP608

P18[4] SPIHB0 DATA0 TP603

P18[5] SPIHB0 DATA6 TP609

P18[6] SPIHB0 DATA1 TP604

P18[7] SPIHB0 DATA7 TP610

P19[0] SPIHB0 CLK TP602

P19[1] SPIHB0_RWDS TP600

P19[2] SPIHB0 SEL0 TP622

P19[3] GPIO1_MB X813.1

P20[0] SPIHB1 DATA4 TP617

P20[1] SPIHB1 DATA2 TP614

P20[2] SPIHB1 DATA3 TP616

P20[3] SPIHB1 DATA5 TP618

P20[4] SPIHB1 DATA0 TP611

P20[5] SPIHB1 DATA6 TP619
(table continues...)
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Table 12 (continued) KIT_T2G_C-2D-4M_LITE Rev-01 pin details

Pin Label Connection details

P20[6] SPIHB1 DATA1 TP612

P20[7] SPIHB1 DATA7 TP620

P21[0] SPIHB1 CLK TP615

P21[1] SPIHB1_RWDS TP621

P21[2] SPIHB1 SEL0 TP613

P21[3] GPIO2_MB X813.2
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5 Additional information
This section provides additional information about the TRAVEO™ T2G Cluster 4M Lite Kit, including advanced
features and test points.

5.1 Test points
Table 13 describes the test points available in this kit.

Table 13 Available test points available

# Test points Description

1 TP501 FX3 UART_RX

2 TP502 FX3 UART_TX

3 TP600 SMIF0 RWDS

4 TP602 SMIF0 CLK

5 TP603 SMIF0 DATA0

6 TP604 SMIF0 DATA1

7 TP605 SMIF0 DATA2

8 TP606 SMIF0 DATA3

9 TP607 SMIF0 DATA4

10 TP608 SMIF0 DATA5

11 TP609 SMIF0 DATA6

12 TP610 SMIF0 DATA7

13 TP611 SMIF1 DATA0

14 TP612 SMIF1 DATA1

15 TP613 SMIF1 SEL0

16 TP614 SMIF1 DATA2

17 TP615 SMIF1 CLK

18 TP616 SMIF1 DATA3

19 TP617 SMIF1 DATA4

20 TP618 SMIF1 DATA5

21 TP619 SMIF1 DATA6

22 TP620 SMIF1 DATA7

23 TP621 SMIF1 RWDS

24 TP622 SMIF0 SEL0
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5.2 Advance features

5.2.1 Programming the EZ-USB™ FX3
To program the EZ-USB™ FX3, follow the steps outlined in this section. Before you begin, ensure you have
downloaded the necessary software. The FX3 Software Development Kit (FX3 SDK) is recommended for
programming and utilizing the EZ-USB™ FX3, as it includes essential tools, drivers, and application examples.

5.2.1.1 Installing FX3 SDK
1. Download the FX3 SDK9)

2. After downloading it from the web, unzip it and open the FX3 SDK Setup application
3. In the Installation Type tab in the SDK window, select your preferred option (in this example, the

Custom option is selected) and click Next
4. In the Selected Release table, leave the default setup unchanged and click Next
5. Carefully read the terms and conditions, then click Accept the terms and conditions and click Next
6. Follow the subsequent steps as prompted and wait for the installation status window
7. After the installation is complete, a window with Contact Information will pop up. Fill in the required

information and click Finish
8. Your FX3 SDK installation is now complete

5.2.1.2 Programming the FX3
1. Before programming the FX3, make sure to connect the jumper X502 on the board to change the FX3

mode to Bootloader mode
2. Connect the USB Type-C to Type-C cable between the USB Type-C connector (X500) on the board and the

USB 3.0 port of your PC. Then, press the FX3 Reset button (S500) on the board
3. Open the search tab and search for Control Center. If you cannot find it, go to Start > All Apps >

Cypress, and you will find it there. Open the Control Center
4. In the Control Center, select Cypress FX3 USB Bootloader Device. Then, go to Program > FX3 and select

I2C EEPROM

9 See the References section at the end of the document to find the link for downloading the FX3 SDK
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Figure 46 Programming EZ-USB™ FX3
5. You will be prompted for the location of the UVC image to flash into FX3. Locate the directory where you

have the UVC image file for FX3. After selecting the UVC image file, check the status of the flashing in the
bottom left corner of the Control Center

6. Once the status shows Programming of I2C EEPROM Succeeded, the FX3 is programmed. You can now
close the Control Center tab and remove the X502 jumper from the kit

7. If you have connected the X502 jumper on your board, the device Cypress FX3 USB Boot Programmer
Device will appear under the Universal Serial Bus controllers tab in the Device Manager, as shown in
Figure 47
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Figure 47 EZ-USB™ FX3 coming under Universal Serial Bus Controllers
8. If you remove the X502 jumper from your board, you will see the FX3 device under the Camera section

in the Device Manager, as shown in Figure 48. Before or after removing the X502 jumper, disconnect and
reconnect the power to the kit to see the device under these tabs in the Device Manager
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Figure 48 EZ-USB™ FX3 coming under Camera in Device Manager
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Glossary

AC
Alternating current

ADC
Analog-to-digital converter

BOM
Bill of materials

CAN
Controller area network

CAN FD
Controller area network flexible data-rate

CAP
Capacitor

CPU
Central processing unit

CSI-2
Camera Serial Interface-2

DAC
Digital-to-analog converter

DC
Direct current

ECO
External crystal oscillator

ESD
Electrostatic discharge

ETH
Ethernet

GPIO
General-purpose input output

HFLASH
Hyper-Flash

HRAM
Hyper random-access memory

I2C
Inter-integrated circuit
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I2S
Inter-IC sound

IC
Integrated circuit

IDE
Integrated development environment

IoT
Internet of things

LDO
Low-dropout voltage regulator

LED
Light-emitting diode

LIN
Local interconnect network

LPO
Low power oscillator

MCU
Microcontroller unit

PC
Personal computer

PMIC
Power management integrated circuits

POT
Potentiometer

QSPI
Quad serial peripheral interface

SCB
Serial communication block

SDK
Software development kit

SMIF
Serial memory interface

SPI
Serial peripheral interface

SRAM
Static random-access memory
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SWD
Serial wire debug

TP
Test point

UART
Universal asynchronous receiver transmitter

USB
Universal serial bus

WCO
Watch crystal oscillator
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